Barcode Label Printing from SAP R/3®

BAR-ONE®
For
R/3®

Reference Guide

December 1, 2000
Rev E
Table of Contents

INTRODUCTION TO SAP R/3 ZEBRA DEVICE TYPES ......................................................... 2

WESTERN EUROPEAN / US SCALEABLE FONTS - ZLB_ZEB.PRI & S9162.CPA (IBM 850) .... 2
BITMAP TRUE TYPE FONTS - ZLB_ZEB2.PRI (LATIN-1 / WINDOWS ANSI) ....................... 4
CENTRAL EUROPEAN SCALEABLE FONTS - ZLB_ZBI2.PRI & S9418.CPA (LATIN-2) .... 4
INSTALL A ZEBRA CODEPAGE .......................................................................................... 5
INSTALL THE ZEBRA DRIVER ......................................................................................... 8

USING THE SAP R/3 ZEBRA DEVICE TYPES WITH OUTPUT DEVICES / PRINT QUEUES .. 13

UPLOADING A SAMPLE FORM FOR ZEBRA PRINTERS ...................................................... 19

TEST PRINTING FROM SAP R/3 TO AN OUTPUT DEVICE / PRINT QUEUE ..................... 23

DESIGNING A LABEL WITH BAR-ONE FOR R/3® .............................................................. 29

TIME .................................................................................................................................. 29
DATE .................................................................................................................................. 30
LINKED FIELDS ................................................................................................................. 30
R/3® VARIABLE FIELD ..................................................................................................... 31
MIXING FIXED AND VARIABLE TEXT FIELDS WITHIN A SINGLE BAR-ONE FIELD. .... 33
LINKING MULTIPLE SAP R/3 FIELDS TOGETHER WITHIN A SINGLE BAR-ONE FIELD. .... 33
USING SAPSCRIPT IF / ENDIF COMMANDS ................................................................. 33
USING SAPSCRIPT INCLUDE COMMANDS ........................................................................... 33
PLACING NON-PRINTABLE CHARACTERS IN BARCODES ............................................... 33
PLACING HARD CARRIAGE RETURNS INTO MULTI-LINE TEXT FIELDS ......................... 33
EAN/UCC 128 AND THE EDIT SCRIPT DIALOGUE ......................................................... 37
VARIABLE GRAPHICS DIALOGUE BOX ............................................................................. 38

UPLOADING LOGOS FROM BAR-ONE INTO SAP R/3 STANDARD TEXT FILES ............. 42

UPLOADING LABELS FROM BAR-ONE INTO SAP R/3 LAYOUT SETS / FORMS .............. 45
Introduction to SAP R/3 Zebra Device Types

SAP AG created Files, for SAP R/3®, Supplied with BAR-ONE® for R/3®:

- ZLB_ZEB.PRI, S9162.CPA (for Scaleable fonts - IBM CP850)
- ZLB_ZEB2.PRI (for Bitmap fonts - Windows ANSI)
- ZLB_ZBH2.PRI, S9899.CPA (for Hebrew - Scaleable)
- ZLB_ZBI2.PRI, S9418.CPA (for Central European - Scaleable)
- ZEBRA.FOR (Sample Form)
- Upload Method Instructions OSS Note 179534.TXT
- Upload Method Instructions OSS Note 179534E.TXT

All of the above files are placed in the BAR-ONE® for R/3® program directory, normally \BARONER3\BIN\, during the installation process.

SAP has developed / configured multiple device types for Zebra printers. The difference between these device types is Codepage.

**Western European / US Scaleable Fonts - ZLB_ZEB.PRI & S9162.CPA (IBM 850)**

This device type (ZLB_ZEB.PRI) and its associated IBM 850 code page (S9162.CPA) have specially been developed for Zebra printers and BAR-ONE for SAP R/3. This device type should be used for Western European character sets, Separate device types are available for Central European and Hebrew etc.

This device requires that you restrict your label designs to only use printer resident scaleable fonts supplied by Zebra or TrueType fonts converted with ZTools using symbols set ZB. This is especially important when using extended character sets.

This device type allows SAP R/3 to convert all data to IBM CodePage 850 before spooling it to the printer. SAP have also developed this custom code page to do the exact mapping for Zebra. You can be assured that any extended European characters contained within your SAP R/3 Database fields will print correctly with any internal printer resident scaleable font.

BAR-ONE for SAP R/3 supports 8 Internal Zebra Scaleable Fonts. These fonts are:

<table>
<thead>
<tr>
<th>CG Triumvirate Family</th>
<th>CG Triumvirate Condensed Family</th>
</tr>
</thead>
<tbody>
<tr>
<td>CG Triumvirate</td>
<td>CG Triumvirate Condensed</td>
</tr>
<tr>
<td><strong>CG Triumvirate Bold</strong></td>
<td><em>CG Triumvirate Condensed Bold</em></td>
</tr>
<tr>
<td>CG Triumvirate Italic</td>
<td>CG Triumvirate Condensed Italic</td>
</tr>
<tr>
<td><strong>CG Triumvirate Bold Italic</strong></td>
<td>CG Triumvirate Condensed Bold Italic</td>
</tr>
</tbody>
</table>

*CG Triumvirate Bold Condensed is the default font supplied with all Zebra printers. The additional seven fonts are optionally available on Flash or EPROM. BAR-ONE for SAP R/3 also supports all of these internal scaleable fonts. CG Triumvirate and CG Triumvirate Condensed are basically the same font as Arial and Arial Narrow True Type fonts (also similar to Helvetica).
Note: The above scalable fonts are not supported with Eltron printers. These printers support internal bitmap fonts. This driver should also be used with Eltron printer resident fonts.

Zebra strongly recommends that you use this device type with SAP R/3.

**Downloading and using additional scalable fonts with ZPL based printers**

For these fonts to be listed in BAR-ONE, you must add/edit the item “AdditionalZebraFonts=B:” to the “[Designer]” section of “SETUP.INI” normally found in C:\BARONER3\BIN\. The entry could also be “AdditionalZebraFonts=E:”. There is no need to use the ^CW command, this is done automatically by BAR-ONE. You must then download the fonts to the printer’s E: or B: flash memory.

Users using non English Windows must also add the following to the “[Designer]” section:

```
ARIO BOLD=Arial Fett
ARIO ITALIC=Arial Kursiv
ARIO BOLD ITALIC=Arial Fett Kursiv
```

This is because BAR-ONE uses these fonts for the WYSIWYG display of the CG Triumvirate family, but “Arial Bold”, etc., are not present for non-English Windows. Please replace the correct value for the language you are using (otherwise the fonts will not look WYSIWYG).

**TrueType Scaleable Fonts**

If your requirements determine that you must use TrueType fonts, then we suggest that you convert the TTF with Ztools. The converted scaleable font should then be downloaded and stored in the printer’s non-volatile memory. Ensure that you use the Ztools “ZB” symbols set, this will generate the converted font to the IBM 850 codepage meaning that you can use this same device type and codepage for all scaleable fonts inside the printer.

BAR-ONE for R/3 can then be told that the font is already available inside the printer and therefore no need to download it as a bitmap true type font. This is done by modifying SETUP.INI, normally found in \BARONER3\BIN\. You will need to add a new section called [InternalFonts] and items such as WindowsFontName=ZPLfontName, Refer to the example below:-

```
[InternalFonts]
Times New Roman=E:TIMESNR.FNT
Arial Black=B:ARIALB.FNT
```
**Bitmap TrueType Fonts - ZLB_ZEB2.PRI (Latin-1 / Windows ANSI)**

This device type (ZLB_ZEB2.PRI) has specially been developed for Zebra printers and BAR-ONE for SAP R/3 created bitmap fonts. This device requires that you restrict your label designs to only use TrueType fonts that are converted to bitmap fonts with BAR-ONE. **Do not use this device type with TrueType fonts that are converted by Ztools** (these are scaleable). This device type allows SAP R/3 to convert all data to Windows ANSI before spooling it to the printer. You can be assured that any extended Western European characters contained within your SAP R/3 Database fields will print correctly. This driver can also be used with Eltron printers and TrueType fonts downloaded as bitmaps.

We recommend that you use the ZLB_ZEB device type rather than ZLB_ZEB2. This device should only be used for EPL printers that are using downloaded TrueType “bitmap” fonts.

**Central European Scaleable Fonts - ZLB_ZBI2.PRI & S9418.CPA (Latin-2)**

This device type and its associated code page have specially been developed for Zebra printers and BAR-ONE for SAP R/3. This device type should be used for Central European character sets.

This device requires that you restrict your label designs to only use printer resident scaleable fonts that have been created by converting TrueType with Ztools using symbol set E2. This is especially important when using extended character sets.

This device type allows SAP R/3 to convert all data to Latin 2 before spooling it to the printer. SAP have also developed this custom code page to do the exact mapping for Zebra. You can be assured that any Central European characters contained within your SAP R/3 Database fields will print correctly.

Important: When designing labels that include Central European Characters, the operating system MUST be Windows 95, 98 or ME. BAR-ONE can’t display Central European UNICODE characters under NT or 2000. English version of Windows 95, 98 or ME will require that multilingual support be installed via Windows Setup (in Control Panel).
Installation of SAP R/3 Zebra Device Types and Codepages

The illustrations below are from SAP R/3 version 4.6c, although SAP R/3 versions 3.0 and higher follow a similar procedure. Early versions may require that Device Types be loaded from the application server, not the PC.

**Ensure the printer is functioning outside of R/3**
Check that the host operating system print queue and the printer are correctly configured before creating the Zebra printer as an OUTPUT DEVICE in SAP R/3. We advise that the printer should be tested by sending a non SAP R/3 label, out-with SAP R/3, to the target print queue.

**Log onto SAP R/3**
Start the SAP R/3 front-end client GUI. Log into R/3 with **administrator rights**. Type in your User name and Password. Press the `<ENTER>` key to continue.

![SAP R/3 Login](image)

**Install a Zebra Codepage**
(If you are using ZLB_ZEB2.PRI then you do not need to upload any codepage. You may proceed to page 9 and Install the Zebra Driver) Begin by entering `/nSA38` in the command line text box located just below the menu bar.

![Command Line](image)

Press the `<Enter>` key or click once on

---

*All product and brand names are trademarks of their respective companies.*
The screen should be similar to that below:

Upload the new Codepage
At the “ABAP/4: Execute Program” screen shown below, type in RSTXCPAG in the Program field to upload the codepage file into the SAP printing system. Click the execute button or press <F8>.
Select Code Page
Next, at the window titled “Upload/Download of Character Set Definitions (Code Pages)
”, enter the appropriate entries for each field as indicated below.

1) Type in the codepage, i.e. 9162, for Character set number field
2) Select the File system: GUI field
3) Select Upload (file -> R/3) option
4) Select the Update/delete when uploading

When all the entries are entered correctly, click on the execute button or press <F8> to continue.

If asked “Do you want to upload and overwrite this code page”, this means that it has already been uploaded. The choice is yours, press <YES> if you are unsure.

Load Codepage from local PC
A pop-up dialog text box labelled “Import from a Local File” prompts for character set filename and its location. Use the browse button to locate the file, i.e., S9162.CPA in the File name entry text box. Zebra supply this file with BAR-ONE For SAP R/3 and it can normally be found in the \BARONER3\BIN\ directory. Click the OK button when you have selected the file. The screen should look like the illustration below:
If no errors occur, the SAP R/3 system will display upload result messages inside the “Upload/Download Character Set Definition”. Otherwise a pop-up error message dialog box will appear on the screen. If any errors occur then repeat the installation and make sure all the entries are correct before continuing to the next screen.

**Note:** There is a known bug with SAP R/3 server versions earlier than 4.0b and uploading Codepages. The codepage uploaded will not be used until the SAP R/3 server is re-booted. If this is an issue then we can change the code page, temporarily using /nSPAD, to a code page that is a close match and already exists on the system such as 1115 or 1103 for CP850, this is a good match, but not perfect!

**Install the Zebra Driver**

The next series of steps outline the import procedure of the device type definition file, i.e., *ZLB_ZEB.PRI* to the SAP R/3 printing system. First, execute the Program Execution transaction SA38 by keying in /nSA38 at the command line:

Press the <Enter> key or click once on the box adjacent to the command line text box.
At the window “ABAP/4: Execute Program”, like the screen above, type in **RSTXSCR**P in the **Program** text box then click the execute button or press <F8> to execute the device type definition import program.

At the next window titled “SAPscript Export to Dataset / SAPscript Import from Dataset”, similar to the screen below, do the following:

1) Select the **Device type** option
2) Enter the device type, i.e. “ZLB_ZEB” for **Object name**
3) Type in “IMPORT” for **Mode** (EXPORT/IMPORT)
4) Select **From/on frontend** (or **File system: GUI** on older releases)
When all the required fields above are entered correctly, click on execute button or press <F8> to start the import process. Ignore all other options.
Allocate a Development Class
The user must either allocate a development class to the device type or make it a local object. The development class is only required if the customer wishes to transport this device type to other R/3 systems. Local object device types can’t be transported to other R/3 systems. This is done from the screen below:

You may enter a Development class and press the save button. Alternatively you can skip the Development class and press the local object button.

Note: You will not see the above step if the device has already been uploaded.
Select the local driver.
The pop-up dialog text box labeled “Import from a Local File” prompts for the device type definition file and its location. Use the browse button to locate the file, i.e., ZLB_ZEB.PRI and then click the OK button to start the upload process.

When the process is complete, update messages will be displayed in the window below.

Note: Please ignore the WARNING SP6X messages. If you scroll down to the bottom, you should see “spooler informed of change”.

The above drivers do not support native SAPscript commands. The above drivers only support SAPscript generated and uploaded by BAR-ONE for SAP R/3.
Using the SAP R/3 Zebra Device Types with Output devices / Print Queues

Before we can use a printer (device type) in SAP R/3 we must create and configure a print queue (output device).

Initiate the Spool Administration program, SPAD, by entering /nSPAD in the transaction command line. Press the <Enter> key or click on the check box adjacent to the command line text box entry.

At the “Spool Administration Initial Screen” windows, press / select the Output Device option.

At the “Spool Administration: List of Output Devices” screen, shown below, press the Change icon.
You should now see the screen below, exactly the same as the previous screen but with a new line of icons. Press the Create icon.

At the “Spool Administration: Create Output Device”, similar to the screen below, do the following:

1) Allocate the **Output Device** name. You may also allocate a shortname
2) Select the **Device Type**, i.e. ZLB_ZEB
3) Enter Location and Message if required
Press the TAB.
For testing and demonstration purposes we recommend that you use “front End printing”. This means that you should complete the configuration of the output device by doing the following:

1) Ensure Host spool access method is set as option F
2) Type in __DEFAULT for Host printer
3) Press the save icon

Below is a detailed explanation of SAP R/3 printing terminology:

**Output Device**
This is the name of the print queue. On older versions of SAP R/3 must be 4 Alphanumeric characters such as ZKM1. In SAP R/3 server versions 4.0 or higher, this can be up to 40 characters.

**Device Type**
This is the name of the printer (device type) and would normally be ZLB_ZEB or ZLB_ZEB2. In SAP R/3 server version 4.6D or higher, these device types will be included and not require uploading. Due to this they will be known as LB_ZEB and LB_ZEB2.

**Spool Server**
This is the name of the server that will do the spooling. Use the browse button to pick a server that has a spool process associated with it (if it doesn’t have a spool server associated with it then it will be highlighted in red).
Access Method
This field must be filled before host printer, although it is listed after it! This is the most important, and complicated, field for setup of print queues (output devices). Summaries of the options are below:

F  PC Front End Printing (requires SAPlpd running)
  Required if no HOSTNAME available, such as remote WAN printing to a standalone PC. This is also the perfect choice if you always want the output to be sent to the same PC as the request for the output came from

L  Local Unix lpd spooler (Print Queue)

C  Local NT or AS/400 print manager

U  Print Server (dedicated server such as UNIX)
  (Something that provides lpd service)

U or S  PC with Windows 95/98/NT4/2000 (requires SAPlpd running)

Destination Host (Like the name of the target PC / print server)
This is not required for F-Front End Printing as the destination host is the client PC that the print request was made from.(requires SAPlpd running).

For U or S, This must be the Host Name of the PC that will have SAPlpd running on it or the Host Name of a dedicated Print Server with print queues setup. The easiest way to determine the host name of a PC is to run SAPlpd and you will find it near the top of the start up window. SAPlpd can be started by selecting Start-> Programs-> SAP Frontend-> SAPlpd.

ZebraNet II print servers can be driven via any of the above methods (as long as there is a relevant print queue setup). Alternatively ZebraNet II devices can be driven direct from SAP without setting up a queue (access method U).

This is not required for L or C as the local server is the destination host.

Host Printer (Like the name of the target print queue on a PC or print server)
When using F, U or S with SAPlpd, this could be “_DEFAULT” (underscore underscore DEFAULT) for the Default Windows printer or it could be the exact name of the printer (not the share name), i.e., “Generic / Text Only”. This is the name listed in Windows->Start->Settings->Printers.

When using L or C this is the “long name” of the printer. This is not the share name.

LPQ Format
This can be ignored.

Location
This is just an optional simple description / comment of where the printer is located.

Message
This is just an optional simple comment / message that you may wish to associate with the specific print queue.

**SAP LPD**

If you have chosen to use access methods F, U or S then you will have to run SAPlpd on the local PC (This is assuming you are not using U with a print server such as Zebra Net).

SAPlpd is a proprietary print server that runs on a PC taking input from the SAP R/3 server and sending it to printers on the local PC. The printers on the local PC normally use a generic text driver. This could be any driver as SAPlpd sends the data in pass through mode (This means you can use a Zebra or Generic text driver).

SAPlpd can be started by selecting Start-> Programs-> SAP Frontend-> SAPlpd. You should see a screen similar to the following:

![SAPlpd Screen Screenshot](image)

SAPlpd needs to be run on any PC that requires a Windows printer driver to be used with SAP R/3. This is the case if you are using Generic Text drivers or full blown Windows drivers.
Uploading a Sample Form for Zebra Printers

Use **SA38 Transaction to upload a sample form for Zebra printers**
In most cases users will modify existing forms rather than create new ones. You do not need to upload this “new” form but it is a good example for future reference.

Start the **Program Execution** transaction SA38 by enter `/nSA38` in the command line text box located just below the menu bar of the SAP R/3 System screen:

Press the `<Enter>` key or click once on the ✅ box adjacent to the command line text box.

**Upload the new Form**
At the “**ABAP/4: Execute Program**” screen shown below, key in `RSTXSCR` in the **Program** field to upload the `ZEBRA.FOR` file into the SAP printing system. Next, click the execute button or press `<F8>`.

At the window titled “**SAPscript Export to Dataset / SAPscript Import from Dataset**” similar to the screen below, do the following:

1) **Select the Form option**
2) **Enter the form name, i.e. “ZEBRA_DEMO” for Object name**
3) **Type in “IMPORT” for Mode (EXPORT/IMPORT)**
4) **Select From/on frontend (or File system: GUI on older releases)**
When the entries for all the requirement fields above are entered correctly, click on execute button or press <F8> to start the import process. Ignore all other options.

**Allocate a Development Class**
The user must either allocate a development class to this or make it a local object. The development class is only required if the customer wishes to transport this object to other R/3 systems (local objects can’t be transported to other R/3 systems). This is done from the screen below:
You may enter a Development class and press the save button. Alternatively you can skip the Development class and press the local object button.

Note: You will not see the above step if the object has already been uploaded.

Select the local Form.
A pop-up dialog text box labelled “Import from a Local File” prompts for file name and its location. Use the browse button to locate the ZEBRA.FOR in the File name entry text box and then click the Transfer button to start the upload process. The screen should look similar to that below:

When the import process is finished, update messages will be displayed in the current window like the screen below.
SAPscript Export to Dataset / SAPscript Import from Dataset

************************************ Start SAPscript Transporter RSTIR3TR ********
Transport object FORM ZEBRA_DEMO is being processed
Language vector used: DE
Original language was set to E
Definition E imported
Object imported and activated

1390 Bytes transferred
Test Printing from SAP R/3 to an Output Device / Print Queue

It is a good idea to check that you have setup the output device correctly. This can be done as follows:

Start the “Standard Text: Request” transaction by entering /nSO10 in the command line text box located just below the menu bar of the current active window of SAP R/3 system. Press the <Enter> key or click on the check box adjacent to the command line text box entry.

At the “Standard Text: Request” like the screen below, enter a name for the Text Name such as ZEBRATEST and click the Create button or press the <F5> key.
At the “Change Standard Text: Request” like the screen below, click the browse button. Then press the browse button.

You will then be presented with the following screen:

All product and brand names are trademarks of their respective companies.
Double click on the / (Line feed). You should now see a screen similar to the following:

Click onto the first column of the first line and you should see the following:

At the cursor type in ~WC (Eltron users should enter U).
We also recommend that you now change the default form that is associated with this standard text file, otherwise when we print the “SYSTEM” form will be used. The system form contains margins that completely stop EPL printers working and can also cause problems with ZPL printers under certain conditions. The form can be changed by doing the following:

Select “Format->Change Form…” (Layout set., on older versions of SAP R/3) from the drop down menu and you will see a screen similar to the following:

Scroll down until you find the entry “ZEBRA_DEMO”, Double click on this (or one click and press the “choose” button). You will now see a screen similar to the following:
Note: The form used is identified above (it’s now ZEBRA_DEMO, not SYSTEM).

Now press the print icon, you should now see a screen similar to the following:
You must enter/edit the following fields:

- **Output device**: Enter the name of the print queue.
- **Print immediately**: Ensure this is checked / ticked.

Press the Print button. If the print was successful then the Zebra printer should print out a configuration label.

The easiest means of debugging what is being sent to the printer is as follows: -

1) Plug in a Laser printer to the port that the Zebra should be attached to.
2) If using a Windows driver on the local PC then change the port to File (create a file on Disk).
3) Use SAP debugging tools (the instructions below depend on the version of R/3 you are using).
   a) Edit Output device definition temporarily to include log information. (use next screen)
   b) Use the spooler (/nSP01). Select output device and press enter to view spooled jobs.
   c) Select job and select Go To->Output Requests from the main menu.
   d) Select Edit->Display log from the main menu
   e) Hit the **More Info** button 3 times (You can also use Hex dump and list to screen or printer)
Designing a label with BAR-ONE for R/3®

This documentation contains the information that is specific to BAR-ONE for R/3®. Please ignore all references to variable data “data types” in the BAR-ONE help system. Features like ODBC and Advanced variable data are not supported in BAR-ONE for R/3® as SAP R/3® is doing the printing, not BAR-ONE. Refer to the help system for information on printer setup and general label design.

Further advanced information regarding SAPscript can be obtained via SAP documentation or 3rd party publications. Zebra recommends SAPscript by Michaelson Buchanan published by McGraw Hill ISBN 0-07-134618-X.

BAR-ONE for R/3 supports variable text, barcode and graphics fields. The available data types; Time, Date, Linked Field and R/3® Variable Field, are listed when creating any new field or editing any existing field. You will see a dialogue like the following (depending on the object type):

**Variable text**

- Data type
  - Time
  - Date
  - Linked Fields
  - R/3® Variable Field

**Time**

This is a user definable time calculated by a clock inside the printer. This requires that your printer have the Real Time Clock (RTC) option. Alternatively, SAP R/3 can supply the time by using the “R/3® Variable Field” data type and using a system variable such as &SYST-TIMLO&. Refer to the help system for more information on the operation of this dialogue box.
Date
This is a user definable date calculated by a clock inside the printer. This requires that your printer have the Real Time Clock (RTC) option. Alternatively, SAP R/3 can supply the date by using the “R/3® Variable Field” data type and using a system variable such as &SYST-DATUM&. Refer to the help system for more information on the operation of this dialogue box.

The advantages of the real time and real date are, it’s the time and date the label was printed, not the time it was spooled to the print buffer.

Linked Fields
This allows you to link one field to one other field. This does not support the linking of several fields together. Multiple SAP R/3® and fixed text fields can be linked together date by using the “Edit script” dialogue box found inside “R/3® Variable Field” data type. Refer to the help system for more information on the operation of this dialogue box.
R/3® Variable Field
This is the data type / dialogue box that is used to place SAP R/3® database and system fields on the label. This can be a simple R/3® field such as &tablename-fieldname& or an advanced field with multiple fields linked together or fields embedded within SAPscript commands. The options for this dialogue box are exactly the same for both variable text and barcodes (they are slightly different for variable graphics and will be described separately).

Variables Info File – (Please ignore this)
This is the name of the file that contains the history list of SAP R/3® fields that you have been using within BAR-ONE for R/3®. This is normally called \BARONER3\BIN\SAP.VAR. This file is automatically written to every time you press the OK button from this dialogue box. The fieldname and sample values are written to the file. You can edit or delete the file, via explorer, if you wish. This is greyed out deliberately, as you don’t ever need to change it.

Identifier/ R/3® Variable Name
This is where you enter the name of the SAP R/3 database or system field. This should only be used for simple fields that do not require concatenation, linking or embedded SAPscript (refer to “Use Script” for advanced fields). The software always generates a default value of ID_00, 01 etc. You should over type this default value with the required variable field name. If you do not surround the field with ampersands (&), then this will be done automatically. You may also use parenthesis for sub-strings, such as &ZUDICITY(20)&. Further string and number manipulation is available via the parenthesis.
options, refer to SAPscript documentation for further information. If for any reason you require other capabilities then refer to “Use Script”.

**Use thisfieldname for Print Quantity**
Select this check box if you wish the Zebra printer to make x number of copies, not duplicate copies, based on the value of this SAP R/3® field. Only one field per label can be tied to the print quantity. If this option is not used then the default print quantity is 1.

This print quantity will also cause fields to increment that have *Automatic incrementing by printer* enabled. This is why print quantity is not refereed to as duplicate copies.

The default quantity, or a default variable name, can be changed / allocated by editing the item QUANTITYTAG= found in the [PDT] section of WIN.INI.

**Use thisfieldname for Copy Quantity**
Select this check box if you wish the Zebra printer to make x number of duplicate copies, based on the value of this SAP R/3® field. Only one field per label can be tied to the copy quantity. If this option is not used then the default copy quantity is 1 (unless it has been set in Label Setup | Number of copies of each label to print to another value).

**Sample Data**
This is simply a representative sample of the data that will be printed. Sample data is used for display purposes on the design screen, and in order to calculate the width of the field. The width of the field can also be calculated by using the Max Chars spin control (See max chars below). Please do not use Parenthesis (Brackets “()”) within sample data as they are reserved characters for BAR-ONE.

**Max chars**
The width of the field is important for correct text alignment, justification and word wrapping. In certain cases, if this value is not large enough, text may word wrap on itself on the same line causing an appearance of what looks like corrupt data. This value automatically defaults to the length of the sample data, but you can extend it by using the spin control or edit box. The maximum length of sample data is 100 characters (The real data stream can be anything upto 3000 characters depending on the text or barcode object). This value is not important for Zebra printers when using:

- Text fields not rotated and not using justification or word wrapping.
- Text fields rotated 90 degrees clockwise and not using justification, word wrapping and not multi-line.
- Any field other than text.

This field is critical when using:

- Any field on an Eltron EPL printer
- Text fields on a Zebra ZPL printers when they are rotated 180 or 270 degrees.
- Text fields on a Zebra ZPL printers where multi-line variable text fields are used.
This field basically sets the size of the object frame. Dragging the handles of text fields with the SHIFT key held down can also set the frame size.

Extended font characters – True Type “bitmap” Fonts
Only required if using text with a TrueType “bitmap” font, not scaleable, and printing non-US characters > 127 decimal. It ensures that the additional character shapes are downloaded to the printer together with the first 95 character shapes that are downloaded by default. When using “bitmap” TrueType fonts with this function, the system automatically downloads:

`.0123456789:
ABCDEFGHIJKLMNOPQRSTUVWXYZ^`
abcdefghijklmnopqrstuvwxyz

Additional characters can be added to the download list by including them within this parameter. Alternatively characters can be permanently added to this list by adding the required characters to the item “AdditionalFontCharacters=” found in the “[PDT]” section of the file WIN.INI.

Note: We strongly advise that you consider using TrueType “scaleable” fonts rather than “bitmap”.

Automatic incrementing by printer – Serial Numbers
Enable this check box if you would like the Zebra printer to increment the SAP R/3 variable field. This field will only increment if the print quantity is greater than 1. Please refer to the above documentation on *Use this field name for Print Quantity*.

Use Script
Select this check box if you wish to use the advanced variable data features of BAR-ONE for R/3®. Do not edit the *Identifier/ R/3® Variable Name* when using this feature. These advanced features include:

- Mixing fixed and variable text fields within a single BAR-ONE field.
- Linking multiple SAP R/3 fields together within a single BAR-ONE field.
- Using SAPscript IF / ENDIF commands.
- Using SAPscript INCLUDE commands.
- Placing non-printable characters in barcodes.
- Placing hard carriage returns into multi-line text fields
- EAN/UCC 128 barcodes
After selecting this check box, press the *Edit script* button. You should see a dialogue like the following:

The contents of this dialogue are SAPscript and the processing is done by SAP R/3. BAR-ONE for R/3® does not do any pre-processing, so please ensure that the syntax is perfect. The main purpose for this advanced dialogue box is to allow you to embed SAPscript within the label design. This means that you should never need to manually modify the ITF file generated by BAR-ONE. If you did manually modify the output, then required a change to the label to be made within BAR-ONE, you would loose these manual modifications when you re-generate the output from BAR-ONE. We strongly recommend that you do not manually modify the contents of the ITF file. This means that you will be able to easily make graphical modifications to labels at any point in the future and not loose any SAPscript coding.

Please ensure that you enter SAP ITF tags at the beginning of each line (except for barcodes, see below). The common SAP ITF tags you will use are:

- `“/ “` Line Feed (used for fixed text and variables)
- `“/:”` Command (used for IF / ENDIF / INCLUDE etc)
- `“/*”` Comments
- `“= “` Extended Line

BAR-ONE will automatically split SAPscript lines, using `“= “`, that are greater than 132 characters. This is done when generating the ITF file.

Below are examples of what customers have done with this capability:
IF/ENDIF, INCLUDE commands and Hard Carriage Returns.
(Used for a text paragraph that supports word wrapping of R/S chemical phrases inside the printer)

The above field is supplied as an example label
“HazChem example for R3.lbl”

Paragraph Text, Hard Carriage Returns and the Edit Script Dialogue
Zebra ZPL printers support multi-line paragraph fields with dynamic word wrapping and/or justification for variable length text fields. The frame of the text field must be dragged, with the shift key held down, to define the width and number of lines. The printer will ignore any hard carriage returns within the data stream. If you wish to include hard carriage returns then you must specify this as backslash ampersand “\&”. This is commonly used to get the next line of data to start at the beginning of a new line. If you want a blank line in between then you will have to specify this twice (we advise that you include a space in between, i.e., “\& \&”).

Note: ELTRON EPL printers do not support word wrapping, multi-line text fields or “\&”.

All product and brand names are trademarks of their respective companies.
IF/ENDIF commands and Hard Carriage Returns
(Used for a multi-line text field on a chemical label)

```
/ Mat.: &ZLLOLABEL1-MATNR:
/ IF &ZLLOLABEL1-D_VBELN&NE &SPACE&
/ Del.: &ZLLOLABEL1-D_VBELN(2)&
/ Item: &ZLLOLABEL1-O_POSNR(2)& &
/ ENDIF
/"
/ IF &ZLLOLABEL1-UNNUMMER(2)& NE &SPACE&
/ UN-Nr.: &ZLLOLABEL1-UNNUMMER&
/ ENDIF
/ IF &ZLLOLABEL1-VBFKL& NE &SPACE&
/ Vbf: &ZLLOLABEL1-VBFKL&
/ ENDIF
/ IF &ZLLOLABEL1-WGK& NE &SPACE&
```

The above field is supplied as an example label
“HazChem example for R3.lbl”

Non-printable characters in a barcode
(Used for a General Motors compliance label containing a specially formatted PDF417 Barcode)

```
\_1E06_1DP\_t_label-lapart\_1DQ\_w_labelqy\_1D\_w_barcode\_1D2O\_w_lpk11\&_2
```

The above field is supplied as an example label
“GMPDF417 example for SAP R3.lbl”
Barcodes and the Edit Script Dialogue
Please note that when using this dialogue with a barcode you must not put any SAP ITF tags at the beginning of the first line. BAR-ONE will automatically put the “/” line feed tag at the beginning for you. You must put tags on subsequent lines. You are required to put tags at the beginning of all lines for text, but not the first line for barcodes. Please be careful using the line feed tag, as this will cause a carriage return/line feed to be placed in the barcode.

Special characters and the Edit Script Dialogue
Zebra ZPL printers allow you to embed special non-printable characters in barcodes via the use of the underscore character “_”. If you wanted to encode the hexadecimal value 1E, Decimal 30 and also known as GS, you would place the text “_1E” within the data stream (without the quotes). You can do this for any ASCII character, please refer to the dialogue box above for an example. For more information, refer to the sample GM compliance label “GMPDF417 example for SAP R3.lbl” supplied with BAR-ONE for R/3®.

Please note that carat “^” and tilde “~” are special character for Zebra ZPL printers. If you require that these be placed in a Variable field then you must encode them using the hexadecimal mechanism, i.e., “_5E” and “_7E”. This is not required for fixed fields within BAR-ONE.

This hexadecimal capability can be disabled by editing \BARONER3\BIN\SETUP.INI, section [Designer], item “FieldHex=Y” to “FieldHex=N”.

EAN/UCC 128 and the Edit Script Dialogue
EAN / UCC 128 barcodes must be formatted using this “Edit script” dialogue box. Depending on the firmware version that your printer is using, you may have to select Code 128 or EAN/UCC 128 as the barcode symbology. ZPL based printers using firmware version X.10 and above should select EAN/UCC 128. EPL based printers should also select EAN/UCC 128. ZPL printers with earlier version of firmware should select Code 128.

We do recommend that you take advantage of the smart EAN/UCC 128 features found in X.10, these include:

- Automatically starting in EAN/UCC 128 mode (using Subset C followed by FNC1)
- Parenthesis “()” and Spaces “ ” can be included within the data, for human readable formatting, but will be automatically stripped out from the barcode.
- Check-digits can be automatically calculated or corrected for Application Identifiers 00, 01 and 02.
- Human readable text is automatically generated and positioned underneath the barcode with parenthesis and spaces (if placed in the data stream).
- Human readable text is automatically sized based on the width and height of the barcode.
For detailed information on EAN / UCC 128, please refer to the following sample label supplied with BAR-ONE for R/3®:

- EAN128(for old firmware).lbl
- EAN128(for NEW firmware).lbl
- EAN128 2(for NEW firmware).lbl

Please contact Zebra for information on the availability of X.10 firmware. (We have beta firmware available for Z, S, XiII and XiIII but NOT 105S / 160S.

Variable Graphics dialogue box
Variable and fixed graphics are supported by BAR-ONE for R/3. Variable graphics require that you use the SAP R/3 data type. This dialog box, shown below, is very similar to what is used above, for text and barcodes.

You can select what possible graphics could be required for a specific field. This ensures that all the graphics will be included within the output generated by BAR-ONE for uploading into SAP R/3. Use the SHIFT and CTRL keys to select multiple objects from the list. The CTRL key can also be used to de-select objects. The current default logo directory is used to build the list of filenames. Alternatively, you may download the graphics to the printer via other means, such as:

- Another label in BAR-ONE (maybe a label called graphics.lbl etc.)
- Ztools
- SAPscript INCLUDE commands (see below)
Variable graphics must be at their original size and orientation (ensure that original is checked in the main dialogue box). You can’t resize or rotate variable graphics within BAR-ONE. The graphics will be downloaded and recalled by their original name, i.e., “fred.bmp” will be downloaded and recalled as “fred”. The name “fred” would be required to be stored in the SAP R/3 variable field.

When using variable graphics you need to ask yourself the following:

**Do I want to store all of the graphics in the printer’s flash memory?**
The advantage to this approach is zero download time, fast first label out and no network traffic. The disadvantage is that, if you regularly add new or edit existing graphics, you have to maintain each printer’s flash memory. If you have hundreds or thousands of graphics this may not be an option due to memory restrictions.

Note: Eltron EPL printers require that graphics be stored in the printer’s flash memory. EPL graphics can’t be uploaded into SAP R/3.

**Do I want to download graphics from SAP R/3?**
There are three reasons why you may want to download logos from SAP R/3, rather than store them in the printer’s flash memory, these are:

a) Too many graphics to fit on flash memory.
b) Would require too much maintenance as graphics are changing regularly
c) Just using 2 small fixed graphics, which don’t really effect download time.

Option C simply requires that you include the graphics in the SAPscript ITF file. This is done via wizards when you press the SAP icon. Options A and B requires that you store the graphics in SAPscript standard text files and recall them with an INCLUDE command. This is documented below:

**Storing graphics in SAPscript Standard Text files**
Standard text files are the ideal solution for storing lots of graphics in SAP R/3 and only downloading what logos you need when you need them. The steps involved on achieving this are:

- Creating ZPL Hexadecimal files for uploading
- Uploading the logos into SAP R/3
- Downloading the logos just before you go to print
- Printing the label
- Clear the printers memory after you finish printing

Each of these steps are described below:
Creating ZPL Hexadecimal files for uploading
Each BMP file needs to be converted to a Hexadecimal format for Storage in SAP R/3. BAR-ONE for R/3 can do this for you, follow the steps below:

a) Design a label containing all of the graphics. If you have hundreds or thousands you may split this into multiple labels. Make sure you check the “original” checkbox (it will be the default after you do the first one). Do not rotate or resize the logos.

b) Do a test print within BAR-ONE (don’t worry about the printer running out of memory)

This puts all of the files that you need in the BAR-ONE temp folder (\baroner3\temp).  

Uploading the logos into SAP R/3
You now need to upload every single logo into a separate Standard text file. This is simple but tedious! Follow the steps in the next section (Uploading logos from BAR-ONE into SAP R/3 standard text files).

Downloading the logos just before you go to print
Add the “include” statement before the ITF SAPscript/ZPL uploaded by BAR-ONE, an example is shown below:

/:INCLUDE &table-logo1& OBJECT TEXT ID ST
/
/*Below are the commands generated by BAR-ONE
/
/* ….SAPScript / ZPL generated by BAR-ONE and pasted by you
/
/*Above are the commands generated by BAR-ONE

You will need an include command for every variable graphic “position” you have on the label. Remember, if you may make changes to the label design and re-upload them, don’t overwrite the include command. It is a good idea to put in a comment i.e., “/*Below….”, as shown in the above example.

Printing the label
The ZPL/SAPscript generated by BAR-ONE does this. As all of the logos are being downloaded and managed by R/3, BAR-ONE does not need to include any of them in the ITF file. When generating the SAPscript from the BAR-ONE Wizards, select “include objects in SAPscript file” (wizard 1) and uncheck the “include logos” check box (wizard 2).

Clear the printers memory after you finish printing
You will need to clear the printer’s memory as to ensure it never runs out of RAM due to the large number of logos that could be downloaded over time. You should clear the printer’s memory after every job.

This means add “^XA^ID*.*^XZ at the bottom of the form. So we should now have something like:
Wizards
The purpose of the wizards are to help you do the following: -

1) Generate an ITF (SAPscript file containing ZPL or EPL)
2) Store objects, such as formats, logos and bitmap fonts, in the printer’s memory or include them within the SAPscript file.

If you do not have a printer connected then please disable bi-directional communications. Doing the following can do this:

1) From the main menu of the label design program select “File->Printer Setup->Main Printer (allow any windows to close).
2) Uncheck “enable status checking every….“
3) Press OK

This will allow you to generate ITF files without a printer being connected. You must not try and download objects to the printer’s memory when no printer is connected.
Uploading logos from BAR-ONE into SAP R/3
Standard Text Files

Start the “Standard Text: Request” transaction by entering /nSO10 in the command line text box located just below the menu bar of the current active window of SAP R/3 system. Press the <Enter> key or click on the check box adjacent to the command line text box entry.

At the “Standard Text: Request” like the screen below, enter a name for the Text Name. This should be the exact same name as the graphic, or the file produced by BAR-ONE. An example for “UL.BMP” would be Text name and click the Create button or “UL”, type in the Text name and click the Create button or press the <F5> key.
At the “Change Standard Text: Request” like the screen below, select Text->Upload from the main menu.

You will then be presented with the following screen:

Select the ASCII and press the Transfer button.

A pop-up dialog text box labelled “Import ASCII file” prompts for File and its location. Use the browse button to locate the file. The graphic files will be stored in the
BAR-ONE temporary directory, normally C:\BARONER3\TEMP\. The file name will either have an extension of “.Z15”, “.Z20”, “.Z30” or “.Z60”, This simply identifies the resolution of the target printer. Click the OK button when you have selected the file. The screen should look very much like the illustration below:

Press the Save button and then select Text->Exit from the main menu. Repeat this step for every single logo.
Uploading labels from BAR-ONE into SAP R/3
Layout sets / forms

Start the “Standard Text: Request” transaction by entering /nSO10 in the command line. Press the <Enter> key or click on the check box adjacent to the command line text box entry.

At the “Standard Text: Request” like the screen below, enter a name for the Text Name such as ZEBRATEMP and click the Create button or press the <F5> key.

![Image of SAP Standard Text: Request interface]

All product and brand names are trademarks of their respective companies.
At the “Change Standard Text: Request” like the screen below, select Text->Upload from the main menu.

You will then be presented with the following screen:

Select the ITF and press the Transfer button.

A pop-up dialog text box labelled “Import ITF file” prompts for ITF File and its location. Use the browse button to locate the file. BAR-ONE for SAP R/3
normally stores ITF files in the `BARONER3\SAP_ITF` directory. Click the OK button when you have selected the file. The screen should look like the illustration below:

![Screen illustration](image)

Click on the on the top line and then press the Select icon 3 times. You should now see a screen similar to the following:

![Screen illustration](image)
Press the **Copy** icon. You have now copied your label into the internal SAP clipboard. Select Text->Exit from the main menu.

Start the “From Painter: Request” transaction by entering `/nSE71` in the command line. Press the `<Enter>` key. In older versions of SAP R/3 this was known as the “Layout Set: Request”.

At the “Form Painter: Request” like the screen below, enter the name for the **Form** name such as `ZEBRA_DEMO` and press the change button.
You will now see a screen similar to that below:
This is the sample form that we uploaded earlier. Please ensure that your existing or new forms utilise the exact same **Basic settings** and **Page Windows**, this will ensure that your margins are 0, Paper is DINA3 and your font settings are similar. You may have problems with page breaks being inserted automatically and corrupt graphics if you do not use these setting.

Now press the Page Windows button.

At the “Form: Change Page Windows” like the screen below, select the Main Windows and press the Text Elements icon.
Note: Zebra printers do not need multiple windows. They only need a single “Main Window”.

<table>
<thead>
<tr>
<th>Window</th>
<th>Description</th>
<th>Left</th>
<th>Upper</th>
<th>Width</th>
<th>Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAIN</td>
<td>00 Main window</td>
<td>0,00 CM</td>
<td>0,00 CM</td>
<td>29,50 CM</td>
<td>41,50 CM</td>
</tr>
</tbody>
</table>
You should now see a screen similar to below:

You now need to paste the contents of the SAP clipboard into this **Main Window**.

You are actually pasting Zebra ZPL or EPL SAPscript commands that are specific to Zebra printers. These commands are also dependent on the resolution of the printer that you are using. This means that if you require support for 200 and 300 dpi, then you will have to design a form for each resolution.

Press the Paste button.

You should now see a screen similar to that below:
Please do not manually modify the Zebra or SAPscript commands that you paste into the Main Window. All modifications must be made in BAR-ONE® for R/3®. The reason for this is any changes carried out on these commands manually, will be lost the next time you export the label from BAR-ONE®. If you require SAPscript to be coded within the printer’s commands, generated by BAR-ONE®, then this must be done within BAR-ONE® using the Edit script dialogue box. You can manually insert SAPscript before and after the commands generated by BAR-ONE®. It is a good idea to put a comment line to identify the begging and end of what BAR-ONE® generated.

Select Text->Exit.

Press the Save Icon.

Activate the form.
**New Forms**
New forms should be created by copying an existing form and saving it as a new name. A good example of an existing form to copy is the “ZEBRA_DEMO” form that we uploaded.

**Existing Forms**
In the real world we expect users to modify existing forms. This may be a “new” form that was already created to print labels for a laser printer.

Refer to the ZEBRA_DEMO form for settings such as standard attributes and font attributes.

**Existing Sapscript, Text Elements and Page Windows**
Keep any existing page windows and text elements i.e., “/E Element1”, as they may be called by the existing ABAP program and could cause errors if they don’t exist.

You should delete any existing SAPscript commands contained within these elements but please ensure that you leave at least one command for each element. This command could just be a comment, an example could be:-

```plaintext
/E Element1
/* This is a comment

/E Element2
/* This is a comment
```

Paste the Zebra commands at the begging of the form in the **Main Window** before any text elements. This will ensure that the commands get processed and that they don’t require a specific element to be called by the ABAP program.